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Chapter 1. Introduction and General Information

Thank you for purchasing RealData’s Comparative Lease Analysis, Version 2.0. We are certain that you
will find this easy-to-use application to be a powerful and versatile partner in your real estate lease
evaluation work.

Please review this manual and, in particular, read this section completely before you begin working with
the program. This introduction will provide you with important information about the program’s
capabilities.

Comparative Lease Analysis is an advanced spreadsheet model designed specifically for use by brokers,
business owners, landlords and leasing specialists. With this program, you can compare the present
values of leasing revenues and costs for up to six different leases. You can compare leases with varying
provisions for CPIs, pass-throughs, build-outs and other considerations and see immediately how the
leases stack up economically.

Comparative Lease Analysis operates in conjunction with Microsoft Excel. You do not need to be an
expert user of your spreadsheet software to make effective use of this model. On the contrary, you can
simply “fill in the blanks” to produce a complete report in just minutes.

We do assume that you are familiar with some of the basic features and functions of your computer, such
as connecting and using your printer, starting up your computer and copying files. For a detailed
discussion of these topics and the many additional features of your spreadsheet program, we recommend
that you consult that program’s documentation.

New for Version 2.0

Version 2.0 includes many significant changes, including a move to a multi-worksheet format and a new
design that incorporates a visual layout similar to that of other RealData products.

Customer feedback has been instrumental in enhancing Version 2.0 to add functionality to what was
already a very powerful program. New features include:

Simplified data entry throughout the program

Additional reports

New navigation menu with links to report printing, worksheets, User Guide and more

A Print Reports dialog box where the user can choose color or black/white printing, select from any
combination of reports to print and send the reports to any available printer including printing to
Adobe Acrobat PDF format.

System Requirements

Comparative Lease Analysis is an Excel workbook that takes up approximately two megabytes of space
on your hard disk. Each completed analysis that you save will also take up another megabyte. You can
copy analyses onto high-capacity media such as CDs for archive purposes to reclaim disk space. Other
requirements include:
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e  Microsoft Excel 2000 or later

e 800 Mhz computer or greater running Windows 95/98/NT/2000/XP/Vista

e 512 MB of RAM or more recommended

e  Alaser or ink-jet printer

e  Comparative Lease Analysis 2.0 is currently available only for Windows operating systems.

License Information

Please read the enclosed license agreement. By downloading and/or installing the software, you accept
the terms of the license. This software is not returnable once you have completed its purchase online. It
is also not returnable once you have received it on compact disc or diskette along with a serial number or
password. Please note that you may make backup copies as you need for your own use.

We believe that you will appreciate the fact that RealData, Inc. has not imposed any scheme to prevent
duplication of the program or of the program installer and expect that you will adhere to the terms of the
license agreement. The program is for your (the Licensee’s) use only. You may not lend, rent, sell, give
away, post on the Internet or via email, or distribute to others in any way the original program,
documentation, installer files, resource files, logos, disk(s) or documentation, or any copies thereof. By
installing this program, you accept these conditions and the terms of the enclosed license.

This software and its documentation (printed and/or in electronic format) are both protected by U.S.
copyright law (Title 17 United States Code). Unauthorized reproduction and/or sales may result in
imprisonment of up to one year and fines of up to $10,000 (17 USC 506). Copyright infringers may also
be subject to civil liability.

Registered users of our programs receive full product support, including notifications concerning program
enhancements and upgrades. If you purchased this program online, then you are registered automatically.
If you have received defective disk media, RealData will replace your disk within 90 days of purchase at
no charge.

You can also register online at http://realdata.com/register.htm.

License Agreement
IMPORTANT

YOU SHOULD READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY
BEFORE YOU INSTALL THE PROGRAM. BY INSTALLING THE PROGRAM, YOU
INDICATE YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS.

License Terms

RealData, Inc. hereby grants you, the original user, a nonexclusive, nontransferable right to use the
enclosed software subject to the terms and conditions contained in this agreement. You assume full
responsibility for the selection of this program to achieve your intended results and for the installation,
use, and results obtained from this program.

In consideration for this license, you agree that the enclosed software and its documentation are for your
use only on a single machine. You may not sublicense this software, nor make copies of this software or
its documentation to sell or to distribute free of charge. You may copy the program into any machine-
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readable or printed form for backup or modification purposes in support of your own use of the software
on a single machine. Certain programs, however, may contain devices to limit or inhibit copying.
UNAUTHORIZED DUPLICATION OR SALE OF THIS SOFTWARE OR ITS DOCUMENTATION
SHALL CONSTITUTE A VIOLATION OF COPYRIGHT LAW.

Term of Agreement

This license is effective until terminated. You may terminate it at any other time by destroying the
program together with all copies, modifications, and merged portions. This license will also terminate if
you fail to comply with any terms of this agreement. You agree to destroy all copies, modifications and
merged portions on termination of this license.

Limited Warranty and Disclaimer

THIS SOFTWARE AND ITS DOCUMENTATION ARE PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE; AND WARRANTIES OF FREEDOM FROM ERROR, UNINTERUPTED
SERVICE, ACCURACY AND THE SUITABLIITY OF RESULTS OBTAINED. THE ENTIRE RISK
AS TO THE QUALITY AND PERFORMANCE OF THIS PROGRAM IS WITH YOU. THIS
SOFTWARE IS LICENSED WITH THE UNDERSTANDING THAT REALDATA IS NOT ENGAGED
IN RENDERING PROFESSIONAL, LEGAL OR TAX ADVICE SHOULD THE PROGRAM PROVE
DEFECTIVE. YOU (AND NOT REALDATA, INC. NOR ANY AUTHORIZED DEALER) ASSUME
THE FULL COST OF ANY REMEDY OR CORRECTION.

RealData warrants that the CD or diskette(s) on which this software is provided will remain free from
defects in materials and workmanship under normal use for a period of ninety (90) days from the date of
your original purchase. RealData will replace at no charge any defective disk returned prepaid within the
warranty period.

SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS, WHICH VARY FROM STATE
TO STATE.

RealData’s entire liability and your exclusive remedy shall be the replacement of the defective disk, as
provided above; or if RealData or its authorized dealer is unable to make such replacement, you may
return the software to the place of purchase and the purchase price will be refunded.

IN NO EVENT WILL REALDATA BE LIABLE TO YOU OR TO ANY THIRD PARTY FOR ANY
LOSS, LIABILITY, PENALTY, OR DAMAGE ARISING IN ANY WAY, EITHER DIRECTLY OR
INDIRECTLY, OUT OF THE USE OR THE INABILITY TO USE THIS SOFTWARE AND/OR ITS
DOCUMENTATION. THIS EXCLUSION OF LIABILITY SHALL INCLUDE BUT NOT BE
LIMITED TO LOSS OF PROFITS, SAVINGS OR ANTICIPATED REVENUES; TO INCURRING OF
PENALTIES, FINES, INTEREST, OR ASSESSMENTS; AND TO CONSEQUENTIAL AND
INCIDENTAL LOSSES OR DAMAGES, EVEN IF REALDATA OR AN AUTHORIZED REALDATA
DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION MAY NOT
APPLY TO YOU.
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General

If any provision of this Agreement is determined to be invalid, it will then be deemed deleted and all
remaining provisions will remain in full force and effect.

This Agreement will govern all updates, copies, and merged or modified versions of this software.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER ACKNOWLEDGE
THAT THIS LICENSE CONSTITUTES THE ENTIRE AGREEMENT BETWEEN YOU AND
REALDATA AND SUPERCEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN US RELATING TO THE
SUBJECT MATTER OF THIS AGREEMENT.

IMPORTANT: THIS SOFTWARE IS NOT RETURNABLE ONCE YOU HAVE COMPLETED ITS
PURCHASE ONLINE. IT IS ALSO NOT RETURNABLE ONCE YOU HAVE RECEIVED IT ON
COMPACT DISC OR DISKETTE, ALONG WITH A SERIAL NUMBER OR PASSWORD.

RealData is a registered trademark of RealData, Inc.

Additional Disclaimers

In addition to other disclaimers contained in our license agreement and this User Guide, be aware that
RealData, Inc. is not in the business of providing tax, legal, investment or professional advice of any kind.
The program is not intended for the preparation of tax returns.
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Installing Comparative Lease Analysis

Installing from CD

1.

o &~ w D

Place the CD-ROM in the appropriate drive.

Select Start > Run. (Mac users: drag the “Comparative Lease Analysis” archive to your desktop.)
Enter d:\setup (where d: is the CD-ROM drive). Mac users: double click on the archive file.
Select OK.

Follow the directions on the screen. Windows users will need to enter the serial number supplied in
the email. Mac users will be prompted for a password to unbundle the archive file; use the alpha-
numeric serial number provided in the email.

NOTE

Serial numbers are case sensitive. When the installer asks for your serial number,
be sure to enter the numbers and the letters in upper or lower case as shown.

Installing from Download

1.
2.

Open the email with the link to the installer file.

Double-click the link and choose the Save File to Disk option. We recommend that you save it to
your Desktop location.

Double-click on the installer icon to begin the installation process (the file name is setupcla.exe).
Macintosh users will click on the icon for an archive file called Comparative Lease Analysis.

Follow the directions on the screen. Windows users will need to enter the serial number supplied in
the email. Mac users will be prompted for a password to unbundle the archive file; use the alpha-
numeric serial number provided in the email.

NOTE

When the installer asks for your serial number, be sure to type the letters, in upper
or lower case as shown, and the numbers. The serial number is case sensitive.

RealData, Inc. 5
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Chapter 2. Files, Worksheets and Reports

Opening and Using Files and Worksheets

During installation, you may have chosen to place an icon on the desktop. If so, you can open a new file
simply by double-clicking that icon to start the program. Alternatively, select Start from the Windows
desktop, then Programs and then RealData. From there, select Comparative Lease Analysis, or any
other RealData program you may have installed.

Because Comparative Lease Analysis is distributed as an Excel template (.xIt) file, which in normal use
should not be overwritten, opening a new file as described above will present a new non-template file
(.xIs) that is modeled after the template. Until you have established this new file, do not attempt to open
the template using File > Open within Excel or Open within any Windows dialog. If you do so, you will
receive an error message.

When you open the file, you will see a splash screen that displays the program name and version. The
window will close after a few seconds and then you should see the first page of an Excel workbook. We
recommend that you immediately save the file with a new name that is meaningful to you and the project
on which you are working. From that point, to re-access that file, use File > Open within Excel or Open
within any Windows dialog, or double-click the file's icon if you saved it to your desktop.

NOTE

You may see an alert message when you start up Comparative Lease Analysis.
The message warns you that you are loading a workbook that contains macros
and that malevolent individuals can embed viruses in such files to harm your
computer. Excel displays this message when it loads any file that contains
macros. It is not reacting to a security threat that it has found in our program. If
you obtained your Comparative Lease Analysis program directly from RealData or
from an authorized dealer or if you downloaded it from our secure web site, you
have no cause for concern. You must select Enable Macros for Comparative
Lease Analysis to function properly.

You must set your macro security level to medium before opening our programs. If the security level is
set to high or low, then you will not be prompted to enable macros.

To change the macro security setting:

1. Open Microsoft Excel.
2. Select Tools > Macro > Security and select the Security tab. Set the security to Medium.

3. Select OK. You will now be prompted to enable macros when opening the Comparative Lease
Analysis program.

Once the file is open, notice that the entire analysis resides in this one workbook file. The workbook is a
collection of worksheets that have been bound together. Each sheet has a specific purpose and you “turn”
the page to move from one part of the analysis to another.

RealData, Inc. 6
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While each sheet has a purpose, they are all also interconnected and share information. For example, the
General worksheet provides information used on the Lease 1 worksheet and both provide data for the
Lease Comparison Report. The real advantage is that you don’t have to worry about keeping any of this
straight; the program does it for you.

Moving from one worksheet to another is very simple. Excel uses notebook tabs as a means of guiding
you to the various sheets that make up a file. A generic Excel workbook has tabs that look like those
shown in Figure 1:

4 4 » W] sheetl / sheetz / sheet3 / Sheet4 ' Sheet5s  Sheets /

Figure 1Excel Worksheet Tabs

The Comparative Lease Analysis tabs have meaningful names, but you may not be able to see all of them
at the same time:

[ 4 » w]Welcome { General / Lease 1 f Lease 2 / Lease 3 f Lease 4 { Lease S f Lease 6 4

Figure 2 Comparative Lease Analysis Worksheet Tabs

To move to a particular sheet, select its tab. You can also use the arrows to the left of the tabs to scroll
through the rest of the tab names. These arrows will take you forward and back through all of the tabs.

If the tabs or any portion of your spreadsheet window ever become hidden from view, you can resize the
window. Select the middle square in the upper right of the window:

/
) x

Figure 3 Windows Screen Sizing Buttons

If you are still unable to view the worksheet tabs, select Window, then Arrange; then choose Tiled from
the list. Select OK.

Comparative Lease Analysis Menu

At the top of the Excel window, you will find the Comparative Lease Analysis menu (Figure 4), which
is added to the Excel menu bar between Window and Help. Whenever you open a Comparative Lease
Analysis file, this menu will appear (assuming that macros are enabled):

RealData, Inc. 7
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File Edit Miew Insert  Formak  Tools  Daka  Window | Comparative Lease Analysis | Help

= 5 = EJ‘ X = - =F D"i]] Save File with a new name. ..

Save File with current name, ..

il + 10 -
Prinkt Reports. ..

Lser Guide

05 - B

Help

Calculakar

RealDaka Wehb Sike
Email Tech Suppart. ..

Abouk Comparative Lease Analysis, .,

1=
xQhO B &EDD

Close

Figure 4 Excel Menu Bar with Comparative Lease Analysis Menu

The first item on the Comparative Lease Analysis menu is Save file with a new name. We
recommend that you immediately use this command to save the template with a new name whenever you
begin a new analysis. Doing so will preserve the original blank template of the program. Should you
accidentally overwrite the template, you must reinstall the software.

Next is the Save file with current name choice. After you have given the template a new name (e.g.,
“Main Street”) use this to save your file as you work on it.

Below that is Print Reports, which allows you to print any of five pre-formatted reports immediately,
regardless of which sheet is currently displayed on the screen (for more information, see below).

The next section gives you easy access to three valuable tools. The first is the User Guide, which you are
reading right now. It requires Microsoft Word to open. The second launches the searchable Help file.
This can give you a quick definition, hint or rule. You will probably want to check this first before
opening the User Guide. The last item in this section of the menu provides immediate access to the
Windows Calculator to help you make simple mathematical computations outside of the Comparative
Lease Analysis program.

The two items that follow allow you to seek web-based help from us (provided you are connected to the
Internet). The first, RealData Web site, will connect you to www.realdata.com, where you can check our
Knowledge Base and support and Learn sections for information that might help you solve a particular
problem. Contact Tech Support makes it easy to communicate with us if you have a specific question.

About Comparative Lease Analysis...displays the program splash screen that indicates the version
number of the program.

Finally, Close the program from this menu. While Close needs no explanation, be assured that you will
be prompted to save your work if you choose this option.

RealData, Inc. 8
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Printing Reports

To print reports, pull down the Comparative Lease Analysis menu, choose Print Reports and select the
report(s) you want to print.

e S

Comparative Lease Analysis Reports

Select the repart(s) ko prink,

Summaty Repark i~
Lease Comparison

Lease 1 Assumpkions

Lease 1 Detailed Report
Lease 2 Assurnptions j

OO00O0onO

Select All Reports Select Printer. ..

I+ Prink in black and white Prink

Figure 5 Reports Menu

You can also print parts of any visible worksheet by pulling down the Excel File menu and choosing
Print. You will probably use this method only if you want to print a particular range or to select printing
options that are not part of the standard report formats. Be aware that if you use the Excel Print menu,
you will not have any of the built-in Comparative Lease Analysis reporting options or layouts available.

Note

Comparative Lease Analysis offers you the ability to create a PDF (portable
document file) when printing from the Comparative Lease Analysis menu. See
below for more information.

The Print Dialog

The print dialog box gives you several options when you are creating reports. It allows you to choose
which device to print to and whether the output should be in color or black and white. Comparative
Lease Analysis produces an assumptions and detailed analysis report for each lease as well as a Summary
and Lease Comparison pro forma.

Note

The colored background on the six lease worksheets, included to improve the
appearance and organization of the data on screen, will utilize considerable color
ink when printed. We recommend that you print these reports in black and white.
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Printing to the RealData PDF Printer

You can to print reports to a PDF file format and send them to a client or colleague as a simple email
attachment. A PDF is an exact digital image of a printed report and can be opened by the Acrobat Reader
available free from Adobe® (www.adobe.com). To print a Comparative Lease Analysis report to a PDF,
you must first install the RealData PDF printer. This print driver is currently available free on your
RealData program CD or via download at www.realdata.com. This driver will work only with RealData
programs that include PDF functionality. Please keep in mind that you may not send your client a copy
of the Excel Comparative Lease Analysis workbook. That Excel file is in fact the program, which is
licensed only for use by you, the user.

To create PDFs, first install the RealData PDF Printer, which is available as a separate installer file. The
installer file, setuppdf.exe, is available at no charge in the Downloads section of the RealData web site
and on RealData software CDs. Again, please note that the RealData PDF Printer will work only with
those RealData software products that have been enabled for this purpose.

To print to a PDF (after the driver has been installed as described above):

Go to the Comparative Lease Analysis menu and choose Reports

From any Print dialog box used to initiate printing, choose Select Printer. See Figure 6 below.
Select RealData PDF Printer.

Select OK.

Select whether you want to print in black and white.

Select Print. The program will then begin creating the file.

No ok~ wDd e

You will be prompted to name the file and to select a location where it should be saved. Name the file
something meaningful, like SmithLeaseAnalysis.pdf. This file can be saved anywhere on your
computer, on a floppy disk or on other portable storage media. Once saved, this file can be easily
attached to email.

8. To view your printout, you need the Adobe Acrobat Reader, available at no charge at
www.Adobe.com (the exact link was http://www.adobe.com/products/acrobat/readstep2.html when
this guide was published). Once this software is installed, just double-click on the PDF file and
Acrobat will open the file automatically.

Note

The Print Dialog Box lets you easily select the printer you want to use, e.g., the
RealData PDF Printer. Once you have clicked OK, this printer will remain active for
this analysis as long as you have it open or until you change the selected printer.
However, if you close the workbook then the next time you open it, the printer
choice will revert to the default printer for your computer. Also be aware that this
selection only applies to Comparative Lease Analysis; it does not change the
printer for any non-Comparative Lease Analysis worksheets you are working on or
any other program you have open.
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Select the report{s) ko print.

[ Summary Report -
Lease Camparisan :‘
[0 Lease 1 Assurmplions

e o

Printer Setup |

Prinker: .
Select Printer. .,
Bl \\PRINTERSI\DESKIET ﬂ
Bl \\PRINTERSILABEL
{E] RealData FOF Printer
Prink
Cancel

Setup... | (04 | Cancel

Figure 6 Selecting the RealData PDF Print Driver

Entering Data

Each worksheet, except for those designed as report-only, has areas that you will use to enter data. Much
of the rest of this User Guide is devoted to discussing the information that you will enter. Depending on
the lease you are analyzing, you’ll use some but probably not all of the data fields.

Most of the fields in Comparative Lease Analysis are spreadsheet cells containing formulas and
formatting that you would certainly not want to erase accidentally. On the visible worksheets, we’ve
displayed these cells in black, locked them and protected the worksheets without a password to prevent
you from accidentally changing any formulas or formatting.

There are also several worksheets that are not visible. These contain proprietary material and calculations
that should not be modified. There are also modules containing proprietary macro code. Do not attempt
to unlock the workbook or macro code. The passwords that protect these formulas and code are not
available to users. Please recognize also that we cannot provide technical support for anything you
yourself may create in the user work areas or for modifications you make to the visible sheets.

Throughout the worksheets we have provided quick reminders of important information in “cell notes.”
You will know that there is a cell note available if you see a little red triangle in the upper right corner of
the cell. If you hover your cursor over the cell note indicator, a comment will appear that will provide
more information about entering data into that cell. Often the cell note will be at the left end of a row, in
the cell where the label for that row is located and it will pertain to the entire row.

To make entering information easier, we have also color-coded the data-entry cells. Cells that appear blue
or purple are generally available for input, as follows:

e  The blue cells are empty or contain 0 or an editable label. They are used for common items such as
the base rent amount or rentable square feet. Some reports have areas that are formatted with blue
text to enhance appearance. These are not data-entry areas and will not accept input.
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e  The purple cells each contain an erasable formula that means, “Use whatever value is in the cell to
the left.” These erasable formulas serve as a typing shortcut and can be found in areas where you are
likely to want to enter the same information for each year.

For example, the base rent for first lease (row 14) has a blue data-entry cell in the first year (Cell D14 in
the Lease 1 worksheet) , but purple thereafter. That means you can enter an amount in the first month and
it will automatically duplicate itself in each subsequent year without your having to type it in. If you
want to change the amount in the second year, however, you can simply type over the formula in that year
and enter a new rate—remember we said the formula was “erasable.” You do not have to enter a rate for
each year, but only if and when a change occurs. This new rate will be used for each subsequent year
until you make another entry in the row.

Keep in mind that you are erasing the unprotected formula whenever you make an entry in a purple cell.
If you want to restore the formula, it is very easy. Looking again at the base rent, if you entered 35 in
year 2, you would be making that entry in cell E14. Before you made your entry, the cell had a formula
that said, “This cell equals the cell immediately to the left.” Since the cell to the left is D14, the formula
you erased was simply =D14. Type this in; the cell will once again equal whatever rate is used for the
previous year.

NOTE

When entering numeric data into the program, always enter numbers only. Do not
type dollar signs, commas or letters along with numbers, or you will see the error
message, “#Value!” in the current or dependent cells. Excel will not recognize
such entries as numbers and will alert you with this error message, which often
cascades to cells throughout the program.

Recalculation

Comparative Lease Analysis is set for automatic recalculation. If you notice that your worksheet does not
fill in with calculated values as you make each entry, then the automatic recalculation has been turned off.

To turn recalculation back on:

1. Select Options from the Tools drop-down menu
2. Select the Calculation tab

3. Select Automatic.
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Chapter 3. Welcome and General

The workbook begins with a Welcome worksheet that displays Internet links for registration, technical
support, articles and other useful resources. We invite you to use the registration link immediately so that
you can receive support and notification of future updates. In addition, we urge you to let us know of any
change in your email or postal address.

What the General Worksheet Does
The analysis begins with the next sheet, which is called General. On this page you will enter information
that is used throughout the analysis and on most reports.

Entering Data in the General Worksheet

Report Information

The first set of data fields on the General worksheet is “Report Prepared For:.” Your entry here will be
used in the Summary Report cover page. Notice the placeholder text, “Prepared For #1.” Be sure to type
something meaningful in this cell or the placeholder will appear on all of your reports. This field is used
only as a label for reports and does not affect the calculations of the program.

Report Prepared For: [David Tenant |

Figure 7 General Worksheet Data Entry Field

Similarly, you can enter appropriate report information in the following five fields. The “Date of Report”
field will display the current date unless you elect to overwrite the formula in the cell and replace with a
date of your choice. The last data entry field on the General worksheet asks for the Discount Rate for
present value calculation (Figure 8):

% Discount Rate (0.00% |

Figure 8 Discount Rate Data Entry

The purpose of the present value calculation is to estimate the present worth of the income stream from
each lease. The rate that you choose accounts for the fact that money to be received in the future is less
valuable than money received today.

When choosing a discount rate, be sure to consider a rate that reflects an average value for the entire term
of the leases.
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Chapter 4. The Six Lease Worksheets

What the Lease Worksheets Do

New to Version 2.0 are individual worksheets for each of the lease analyses. Each of the six worksheets
is identical and is divided into two sections: the Assumptions or data entry section, which is used to input
the details of the particular lease, and the Detailed Report, a pro forma presentation of all details based on
the assumptions.

Entering Data in a Lease Worksheet

Assumptions

Data entry begins on row 4 where you enter text to indicate the name of the building, the suite number
and the property address. Note that you should not let the text for the address extend beyond the right
margin of the form in column M or the address will not fit neatly on the reports.

Enter the rentable square footage in cell C6. The rentable square footage entry is a required input used
throughout the calculations for this lease. This cell requires a minimum value of 1. You must also enter a
value for usable area of the leasehold immediately below in cell C7. If your entry is greater than 0 but
not greater than 1, it represents a percentage of the rentable square footage. If it is greater than 1, it
represents the actual usable square feet. A value of 1 indicates 100 percent, i.e., that the rentable and
usable footage are equal. This cell requires a non-zero value.

Be sure to enter a lease term in cell C8 — this is a required input. Only values between 1 and 10 are valid.
This value will be used to calculate average rates so it should never be less than the number of years for
which you enter lease income.

Building: OakLeaf Office Park Suite: 100 Ad
Fertable =f; b 2,000 Leaze beginz: 1M72005 Owyner: Yourtowen Properties, LLC Floor 2
Uzahkle % of RSF: b 095 Rent begins: 152005 Managet: David Smith Total f
Leasze term (years): M0 Baze year: 2005 Park, resrvd: "0 Expan
MR discount rate: Y3.00% Year buitt: 2000 Park, unres: Y30 Total k
Comments: b high speed internet connection already in building Wkclar

snawy removal included in leaze

Figure 9 Lease Data Entry Assumptions

The present value discount rate in C9 is displayed in black. This is not a data entry cell; the value is
displayed here based on your entry on the General worksheet.

The remaining data entry fields in rows 6 through 11 are informational only and will appear as text
content in reports but will not be used in calculations.
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Base Rent & CPI Escalation

Base rent is entered in row 14, expressed in dollars or dollars per square foot. Enter an amount for each
year for which you have rental income for this tenant. If you want the analysis to go out less than 10
years, you must remember to leave the years you are not using set to zero. If your entry for base rent is
less than $500, then it represents a dollar-per-square-foot amount. If it is $500 or greater, then it
represents a total dollar amount of base rent for the year.

Year 1 Year 2 Year 3 Year 4 Yearh Year b
Basze Rent
Erter amourt tatal § or $Isf):‘ f35.00 f35.00 f35.00 f35.00 f35.00 f35.00
CPl Ezcalation
Tenant pays x% of CPL * 100.00% 100.00% 100.00% 100.00% 100.00%
Eztimated CPI%: b 2.00% 2.00% 2.00% 2.00% 2.00%

Figure 10 Base Rent and CPI Escalation Data Entry

Enter CPI escalations in rows 16 and 17. Enter the percentage of the CPI increase that is applied to the
lease. Typically this is 100 percent, although it can be any percentage between 0 and 100. The amount
you enter in year 1 will automatically copy across all of the rest of the years unless you make another
entry in the row (there is an “erasable” formula in each cell from year 2 through year 10 which says, “Use
the same amount as in last year’s cell.”). If the lease provides for a CPI increase, enter your estimate on
row 17. You must make your entry as a percentage. You should only make an entry in a year where the
lease actually calls for a CPI escalation. This row will not echo your first entry all along the row.

Pass-Through Expenses

Building expenses that are paid as part of the lease are entered in rows 19 through 37. New to Version 2
is the option of aggregating these expenses into one entry or itemizing up to three different pass-throughs
by selecting the radio button in the Pass-through Display control on rows 19/20:

Pass-through Display =
|7 1 Single o Multiple

Figure 11 Pass-Through Display Control

Whether you choose a single pass-through expense or multiple categories, data entry is identical for each
section. Notice that the name of the expense in column B is shown in blue. You can change the name of
the expense to suit the needs of the lease.

Begin by entering the percentage of the expense that the tenant pays over the expense stop in row 21. Itis
not uncommon for the landlord to pay up to a certain number of dollars of a given expense and then stop.
The tenants then pay the rest, each one contributing a specified percentage of the remainder. This entry is
that percentage. Your entry for year 1 will duplicate automatically across the row.

In row 22, enter the amount, in dollars per square foot, that the landlord will pay before the tenants’
contribution begins. If the landlord pays nothing, then the stop is 0. Your entry for year 1 will duplicate
automatically across the row.
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Taxes
Tenant pays x% over stop 100.00% 100.00% 100.00% 100.00% 100.00% 100.00%
Stop, Fr=f: £5.00 5.00 5.00 5.00 5.00 Fa.00
First vear estimate, frzf: 5274
Groweh rate, % 3.00% 3.00% 3.00% 3.00% 3.00%
Cap, $i=f F145.00 F145.00 F145.00 F145.00 F145.00 F145.00

Figure 12 Pass-Through Expense Data Entry

In the next row, make a single entry for the estimated first-year amount of this expense, expressed in
dollars per square foot. Your entry is the total amount of the expense, regardless of who pays for it.

The growth rate in row 24 is the amount that your first-year expense estimate will change each year.
Enter a value as a percentage.

The last entry is the expense cap. Enter an amount on row 25 for the maximum dollar-per-square-foot
amount that would be passed through to the tenant. This figure typically should be greater than both the
stop and the first-year estimate, otherwise the amount passed through will be zero. If you enter zero, then
the program will ignore the cap feature, i.e., there will be no limit to the amount of this pass-through.

NOTE

The functionality of the expense cap has changed from the previous version of
Comparative Lease Analysis. In version 1, an entry of zero signified that the cap
was zero dollars and therefore there was no pass through. In version 2, an entry of
zero means that there is no limit on the amount passed through to the tenant. In
other words, there is no expense cap.

Other Expenses and Allowances

If the tenant has a separate charge for parking, enter it on row 39 expressed in dollars per rentable square
foot of the leasehold space or in total dollars. If your entry for parking expense is less than $500, then it
represents a dollar-per-square-foot figure. If your entry is greater than or equal to $500, then it represents
a total dollar amount of parking expense for the year.

Parking Expense (total § ar $Isfj:‘ FG75.00 FE75.00 F675.00 Fro0.oo Fro0.oo Fro0.oo

Figure 13 Parking Expense Data Entry

The tenant may have a separate charge for security; if so, enter it on row 48. Similar to parking expenses,
if your entry for security expense is less than $500, then it represents a dollar-per-square-foot figure. If
your entry is greater than or equal to $500, then it represents a total dollar amount of security expense for
the year. Note also that you can change the name of this expense to suit the needs of your lease.
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Year 1 Year 2 Year 3 Year 4 Yeara Yearf
Security Expenze (total § ar $.l'sfi F3.25 F3.20 F3.34 Fa.40 F3.44 F3.44

Other Expense (total 3 or /sty §1,500.00  §1,53000  $1,560.00  §1,590.00  §1,620.00  §1,650.00

Figure 14 Security and Other Expense Data Entry

Row 50 is provided to include one additional expense if necessary. Data entry follows the same rule as
parking or security, representing either dollars per square foot and total dollars with the same behavior at
the break point of $500.

The tenant may bear costs of fitting up the leasehold space. If your entry for tenant improvements is less
than $1000, then it represents a dollar-per-square-foot figure. If your entry is greater than or equal to
$1000, then it represents a total dollar amount of tenant improvements. Enter the number of years over
which this expense should be amortized; typically this is the life of the lease.

Tenant Improvements
Total § amount or Fraf: * F148.00
Amortized over x yYears: 10 wears

Build-out Allovwance
Tatal § amourt ar et b F2.00
Amortized over x years: 10 years

Figure 15 Tenant Improvement and Build-out Allowance Data Entry

The landlord may also make a contribution to the fit-up. Again this may be spread out over a period of
years. If your entry for the build-out allowance is less than $1000, then it represents a dollar-per-square-
foot figure. If your entry is greater than or equal to $1000, then it represents a total dollar amount of
build-out allowance. Enter your figures on rows 57 and 58.

In addition to giving free rent during the 10-year period of the analysis, you can also give free rent for
some number of months immediately before the 10-year analysis begins by making an entry in row 61.
We call this period "Year 0." For the purpose of our analysis, Year 0 is some humber of months (no more
than 12) that may occur before the actual term of the lease begins. The program will take this time into
account when calculating the discounted value of the lease's income stream. Even though the tenant may
receive free rent during "Year 0," the landlord may still choose to collect pass-through expenses during
that time. If so, enter the amount of those expenses, expressed in dollars per square foot per year in row
62. You may also choose to give free rent at any time during the 10-year period covered by this analysis.
If so, enter the number of months of free rent for any year in row 63.

Free Rerit
# free morths in "year 00 3
Total pazs-thru, fisf, Year 0 F2.845
# free months in years 1-10; N 2 I} I} 1 I} I}

RealData, Inc. 17



Comparative Lease Analysis User’s Guide

Figure 16 Free Rent Data Entry

The tenant’s moving costs should be entered on row 66. If your entry for tenant's moving cost is less than
$500, then it represents a dollar-per-square-foot-figure. If your entry is greater than or equal to $500,
then it represents a total dollar amount of moving cost.

Relocation Allowance (row 69) is effectively an offset to tenant's moving costs. If your entry for tenant's
relocation allowance is less than $500, then it represents a dollar-per-square-foot figure. If your entry is
greater than or equal to $500, then it represents a total dollar amount of relocation allowance.

Moving Cost
Tatal § amourt or st b F4.25

Relocation Allowance
Taotal § amourt or $irzt: b F1.50

Figure 17 Moving Cost and Relocation Allowance Data Entry

The program accommodates one additional line item to cover other concessions made by the landlord to
the tenant. If your entry for other concessions is less than $500, then it represents a dollar-per-square-foot
figure. If your entry is greater than or equal to $500, then it represents a total dollar amount of other
concessions.

Cther Concessions
Total § amourt or st N $1.20 $0.50 $0.25 $0.00 $0.00 $0.00

Figure 18 Other Concessions Data Entry

Data entry ends at row 72. The sections below in rows 75 to 137 display the calculated values for the
lease first in total dollars and then in dollars-per-square-foot. The report also shows the effective rent
each year, the effective annual rate, the average effective rate, net present value and the total rent
commitment.

Effective rent is the annual base rent adjusted by all of the items shown in rows 15 through 72, from
"CPI" through "Other Concessions," expressed as a dollar amount. Effective annual rate is the same as
the effective rent, except it is expressed in dollars per square foot. Average effective rate is the effective
rate as an average over the number of years indicated in the lease term in cell D8.

Figure 19 below shows a completed detailed lease report.
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LEASE 25 DETARLED REPORT (in total dollas)

Branshywing Ceamimon
Suite 200
100 Commarca Dr,

Basze Rend
CP1Escalation
Paze-Through Expensas
Elacimicity
Qtrer Op. Expense
Taxes
Parkng Expense

Socurity Expanise (§ or §i54)

Oittier Expencsi (§ ar $156
Teemant Imiprovi ments
Buiil B Allivan e

Free Rent

Mirving Ciost

Relocabon Allowanoe
Other Concessions

Effactive Rant

Effectie Anrudl Ritarrs!
Effpctive Anrual Ralenist

Foarape Effactive Ralerst
Forarage Effective Rateisst

WPV, Effective Ratelrsf
HPY, Effacting Riateisst

Fentable SF 4,500 Lease lerm 10years A 3r2004
Uszable 5F 4500 Discount rate I8 FM
Load faclor 0.00% for NFY 10.00%
Yar 1 “fear Yaar 3 irar 4 Year s Year B Year 7 irdr B Wiar Year 10
202500 202 500 202,500 202,500 202500 202,500 202 500 202,500 202500 H2500
6,075 12,332 18,777 15416 32,253 39,196 46 549 54,01 BT
4275 4,381 4448 4,537 4627 4,720 4814 4850 5,009 5109
1} 0 /] n 1} n ] 1] n u}
B.750 BATS 7,318 7,674 B0 8,290 8,545 8,507 8,073 9,344
1135 1,125 1125 1125 1135 1,125 1,125 1125 1125 1015
0 0 ] o L} 0 ] o o 1}
L o ] o L1} L ] o o 1}
i} ] ] i} i} o ] 1] i} i}
450 -850 -850 -450 -450 -450 -450 -450 -450 -450
-16875 ] ] i} i} o ] 1] i} i}
4,500 0 ] o 1} 1} ] 1] n i}
1135 ] ] 1} 1} o ] o [} u}
o ] o n [} o ] 1] o Q
$300T00  $220556  S2IT AT RI363  SR1.35T  S2e843R S285831 203443 FIMITT $3THMS
$44.80 4002 L5051 £5204 $51.81 £55 M $56.05 £52 54 $60.22 16208
$44.60 $40.02 £50.51 5204 $53.61 £$55.11 $56.85 £5854 $60.28 $62.08
$54.2T over 10years
$54.7T ovar 10 years
§337.52 Total Comamittmant 2443310
31152 NP at 10% §1.4738385

Figure 19 Completed Lease Detailed Report (total dollars)
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Chapter 5. Summary Report

The Summary Report worksheet is designed as a presentation report. It summarizes information about
each of the leases in a compact two-page layout.

There is no data entry on this worksheet. You can print it using the Comparative Lease Analysis report
menu.

Overview and Summary

Crwmer: Propecty Pafners, LLC
Cambridge Square Manager Drawid Smith Rentable sf S000  Todal floor sf 10,000
400 Pacific 51, Uszable sf &.000 Expansion sf, 5000
200.8 Totad bidg. =f 120000  Load factor 0U00%
Floar 2 Year built 1997 Lease tam 0 years  Parking, wresennd 150
Lease beging 1A200E  Secunty yes  Oparating hes., weekend 95
Rent baging 1120058 HVAL ik Dpirating b, wisskddy 95
Base year 05 Loadng docks: no Alterhours charges: i
Comrents: First quality bull Sing; suite i ready 10 oeupy
Cromer: Beandywine Group, Inc.
Brandywine Common Manager First Managerment Cog Rentable sf 4500  Todal floor sf 25000
100 Commaerce Dr, Usable sf 4500 [Expansion sf 2000
Suite 200 Totad bidg. =f 0000 Load factor 0% Parking, resermd 20
Floar 1 Year built 1990 Lease tamn 0 years  Parking, wiresennd [Zun]
Lease beging 1A200E  Secunty yes  Oparating hes., weekend 95
Rent baging 1120058 HVAL ik Dpirating b, | wisskddy 95
Base year 05 Loadng docks: no Alterhours charges: i

Comments: High speed irame accass inthuded
Expellent loca®on
Motec This kease includes 3 months free rend pror Bo Year 1. Tenand pays expenses al §0 st duting this tirme.

Cremer: Waorihside Developeent

Gith Street Square Manager Baest Manage, Inc. Rentable sf 4000  Todal floor sf 5000

125 Sinth 5t Usable sf 4000 [Expansion sf 2500

Suite 60D Totad bidg. =f 50000 Load factor 0U00%

Floar 5 Year buyilt 00 Lease tamn 0 years  Parking, wresennd a0
Lease beging 1A200E  Secunty yes  Oparating hes., weekind 95
Rent beging 1A20058  HVAC yes  Operaling hes, weekday 95
Base year 05 Loadng docks: no Alterhours charges: i

Comments: Best Space Id our nedds.

Figure 20 Completed Lease Summary Report
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Chapter 6. Lease Comparison Report

This worksheet is also designed as a presentation-style report that allows you to see the most important
information about each lease on a single line. It is suitable to give to a lender or partner as a comparison
of essential data about the leases, either by itself or in conjunction with the Summary Report and or lease
detail reports. You can print it using the Comparative Lease Analysis reports menu.

There are only two data entry cells on this worksheet at the top of the page in cells C5 and C6. These
entries, each of which represents a year between 1 and 10, adjust the data presented in columns D through
G for the effective rent and rent-per-usable-square-foot. Note that the remaining columns, H through L,
represent data for the entire term of the lease in question (as indicated in cell D8 on the lease’s worksheet)
up to 10 years.

The report computes an index for the leases, which is a single number that represents the relative cost of

each lease. The lease with the lowest Net Present Value has an index value of 1.000. Every lease that is

more costly has a proportionately higher index. Thus a lease with an index of 1.082 has a NPV that is 8.2
percent higher than the least expensive lease.

‘ Lease Comparison
Yo 1 fiear 10 W 1 Waar 10 | 10-yr Aag. | P0-yr Aog H0-yr Tesal NP Irdex
Lesse Efisctive Fart | Effaciivd Rem Rertivef Rianbirsf Rentfrsf Rertfiesf | Commitmant 8 10%

Flatiron Byiding
Sugite 100 230 300 §230 300 47 00 $47.00 $47 .00 $47.00 2,303 000 §1 4654368 1.000
Commarce Plaza
Sigte 100 $247 500 $24T 500 $50.00 5000 50,00 $50.00 $2.475 (00 $ETITM 1075
Brach W'alle
e $200 500 $2202 500 55 00 $55.00 5500 $25.00 §2 925 (0 $1989888 1,270
Cambridge Square
208 §240,000 §240 D00 §48.00 §4B.00 00 4800 §2.800 000 §IE%0E 1042
Brandysina Commdn
Siite 200 5200, 700 279345 §4480 208 5437 ey §2a425m SIATIEE 1006
Brasrweay Square
St GO0 §274 604 SuTSE s %9 s 5T $3)002 734 SIETET 193

Hote: The amounts Shaws in the Second o Suth columns répresent the vedes specified in those columnng, The amounts Shown 45 airages, 1008 commitment and NPY
covir Bhi ectie 10-year penod

Figure 21 Completed Lease Comparison Report

RealData, Inc. 21



Comparative Lease Analysis User’s Guide

Chapter 7. User Work Area

One blank worksheet is provided for your use. You may use these for performing incidental calculations
or, if you are proficient with Excel, to design a subsidiary spreadsheet of your own that you link into
Comparative Lease Analysis.
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